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Congratulations on your purchase of Pianoteq - the starting point of a
brand new generation of pianos, developed from mathematical
research done at the Institute of Mathematics of Toulouse at INSA
Toulouse, France, and offering unique possibilities to make the piano
behave and sound just the way you like.

For support issues and latest news about our products, please visit
our website at www.pianoteq.com. If you have any questions or
comment, let us know. We always listen to our customers.



http://www.pianoteq.com/
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1 Introduction

1.1 The fourth generation of pianos

The first generation of pianos, starting in 1698 with Cristofori’s pianoforte, came to
maturity at the end of the XIX century with the acoustic grand concert piano. It was
followed in the XX century by electro-acoustic pianos, and then by digital sampled
pianos. Now, at the beginning of the XXI century, Pianoteq is the first instrument of the
fourth generation of pianos, based on a true physical modelling and offering
extraordinary playability and expressiveness.

With Pianoteq, you can adapt the piano sound to your own taste. Unique parameters
that model the behaviour of real pianos result in great realism, until now only to be
experienced on real acoustic pianos.

Using 32-bit internal computation, the calculated piano sound is free from quantization
noise. True dynamic timbre results, from the faintest pianissimo to the strongest
fortissimo, for all 127 MIDI velocities available for each note played.

Everything that characterizes a real piano is there: the mechanical noises (optional), the
complex sound of pedals and strings in interaction, the percussive impact on staccato
play (short notes), and of course, most importantly, the beauty of the piano sound.

The second generation brought innovative sounds (such as the Fender Rhodes, Wurlitzer,
Yamaha CP, and others), whereas the third generation only reproduced recorded
samples. Based on an effective physical model, Pianoteq allows you to adjust and
stretch parameters, resulting in new sounds and performance styles. Pianoteq is both a
way to emulate existing pianos and an innovative tool for music creation.

Pianoteq is in fact the first virtual piano factory: it can produce new brands as well as
copies of historical instruments, from harpsichords or pianofortes to more recent
electro-acoustic pianos.

Other instruments of the percussion family are regularly added to the Pianoteq
collection. Visit our website www.pianoteq.com and discover our latest creations.
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1.2 What makes Pianoteq outstanding

It is the first of a new generation of pianos, issued from an outstanding
breakthrough technology based on physical modelling, which is foreseen as the
technology of the future. Notes are really played (“constructed” in real-time,
like on a real piano), not just read from the disk or the memory. This explains
why the sound is alive, not static: it is not a simple recording, it is as genuine
instrument that responds to the pianist’s finest interpretation.

« It has been developed in the prestigious Institute of Mathematics of Toulouse, at
the Institut National des Sciences Appliquées in Toulouse, France. Two specialists
from this laboratory have been working hard to create this beautiful instrument.
Conception of the physical model is from Philippe GUILLAUME, piano tuner,
musician, and mathematician whose “Grail” is finding the equations for the
“piano soul.” Implementation is from Julien POMMIER, engineer and
mathematician, who implemented the physical model to work in real time.

» |t is light: it does not require storing huge data involving a whole collection of
DVD’s, since it only needs an up-to-date CPU for computing all sounds in real
time. It loads easily into RAM, and installation is instantaneous. No problem using
it on a modern laptop.

» It can handle ultra low latencies with good audio drivers on a recent CPU.
e It offers a beautiful collection of stunningly alive instruments: pianos, rare

historic harpsichords and pianofortes, electro-acoustic and electric pianos,
chromatic percussions, etc.



1.3 Pianoteq versions

Pianoteq is available in three versions:

e PIANOTEQ STAGE (formerly PIANOTEQ PLAY) is for musicians who want to plug it
in and play without tweaking the physical model. It includes standard features
such as velocity curve, dynamics, action settings, EQ, tremolo, wah-wah, chorus,
compressor and other effects.

 PIANOTEQ STANDARD offers in addition powerful tools to tweak and adapt the
physical model, as well as the positions of the microphones.

* PIANOTEQ PRO goes even further. Its Note Edit feature allows those who require
complete freedom in note shaping to edit the parameters note-by-note.

All versions offer the same sound, instruments and playability but differ in the range of
features and settings. The table below summarizes the main differences between the
three versions.

PIANOTEQ PIANOTEQ PIANOTEQ
STAGE STANDARD PRO
Grand pianos D4 and K1

Commercial add-ons [1]

KIViR instruments (free)

Preset (fxp) loading [2]

ANANENENAN

Audio effects

Piano model tweaking

ANANENENENENEN

Microphones setting

ANANENRNANENENEN

Note Edit (note-by-note editing)

[1] Commercial add-ons are sold separately and can be loaded in any Pianoteq version.
[2] In PIANOTEQ STAGE, preset loading is limited to parameters that are present in the
interface. Presets built with PIANOTEQ PRO can be loaded in PIANOTEQ STANDARD
without any limitations.

This manual describes the general features that can be found in Pianoteq. Depending on
your version, some of them may or may not be present.



1.4 Features in short

Pianoteq is equipped with all of the features you could dream of:

Continuous velocity from pianissimo to fortissimo, with progressive variation of
the timbre: that makes exactly 127 velocities! A sample-based software program
would in theory require hundreds of gigabytes for all these velocities
Complex resonances that only a model can reproduce in all its richness:
o Sympathetic resonances of all strings, both without and with sustain pedal
o Duplex scale (the undamped string parts which come into resonance)
o Damper position effect when key is released (variable overtones damping)
o Other specific effects like staccato and sound continuation when pressing
down the sustain pedal a short time after key release (re-pedalling)
Extended key range to 105 keys for some grand pianos (D4, K1, YC5, etc.)
Timbre modification of repeated notes, due to the hammer striking strings which
are already in motion instead of being still
Four pedals:
o Progressive sustain pedal, allowing the so-called “half pedal,” but also
quarter or tenth’s pedals if you want! '
o Sostenuto pedal, allowing you to hold some notes after release without
pressing down the sustain pedal
o Harmonic pedal, allowing you to play staccato while maintaining the
sustain pedal resonance
o Una corda pedal, also called the soft pedal, modifying the sound quality
or timbre by shifting the piano action to the right (on grand pianos)
Variable lid position
Natural instrument noises including action key release noise, damper noise at key
release (bass notes) and sustain pedal noise: pedal velocity dependant “whoosh”
produced by the dampers rising altogether from the strings or falling down
Choice of microphone position and multichannel mixing (up to 5 mics, 5 channels)
Microtuning and scala format files import
Keyboard, pedal and note-off velocity settings
Sound control via equalizer and dynamics
Built-in convolution reverberation, allowing you to import WAV impulses
Standard effects including delay, chorus, flanger, tremolo, wah-wah, amplifier
and a compressor
Original hammer bouncing feature, interesting for chromatic percussions
(marimba, xylophone, cimbalom...).

' If your piano supports a fine enough MIDI progression when using the sustain pedal.



2 Installing and starting Pianoteq

Pianoteq works on computers equipped with Windows XP or later, Mac OS X 10.5 or later
(Universal Binary) and Linux (x86). You can use the stand-alone version or use Pianoteq
as a VST, Audio Units or RTAS instrument. We recommend visiting www.pianoteq.com,

where you will find the latest information and a detailed FAQ.

vsh| (@) (RTAS

F Audie Ihriits REAL-TIME AUDIOSUITE

2.1 Installation for Windows

Execute the installation program file pianoteq_setup.exe. Activation is required when
launching Pianoteq for the first time. Just follow the on-screen instructions. ASIO
drivers are necessary for obtaining a low latency. If using a soundcard that is not
distributed with its own ASIO drivers, you can download ASIO drivers at
www.asio4all.com.

Optimization
If you experience pops and cracks when playing, watch the audio load and CPU
frequency in Options » Perf:

74 @ # B i\

MIDI Add-ons General About

CPU identification  Intel{R) Core(TM)2 CPU T5600 & 1.83GHz, M15/56/Fb, x2

CPU frequency 1B33MHz

Perfarmance index 27

Audio load I i

"f Multicore rendering f CPU Owerload detection

Red bars in the graphic indicate an overload. In that case, look at the displayed CPU
frequency. If this frequency varies or stays below the normal frequency of your CPU, it
comes from the Power Management setting of your computer which should be set to
“High Performance”.

10
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2.2 Installation for Mac OS X

Click on the Pianoteq package and follow the instructions. Activation is required when
launching Pianoteq for the first time. Just follow the on-screen instructions.

2.3 Using Pianoteq stand-alone

Using Pianoteq stand-alone is very simple. Launch Pianoteq and specify your audio and
MIDI Devices settings in the dialogue box: you are ready to play.

2.4 Using VST hosts

Pianoteq can be loaded by any VST host. You will need to specify, inside the VST host,
your MIDI device and the driver you are using.

Warning

Most VST hosts save your modifications and reload them when you restart. If you hear
some strange sounds, make sure that all parameters are at their default values. Check,
for example, if the velocity and equalizer curves are correctly defined.

2.5 Hardware requirements

Pianoteq can be used with any MIDI compatible keyboard. We recommend a touch
sensitive keyboard, such as one with full weighted keys simulating the hammer response
of a real piano. See tutorial section 12.4 for adapting Pianoteq to your keyboard in the
best way. For half and quarter pedalling, a progressive sustain pedal is required.

The requirements for using Pianoteq successfully are:
» Recent CPU (dual/quad core recommended)
512 MB RAM
e ASIO compatible sound card and drivers (Windows users)
* Internet connection (however installation on a computer that is not connected to
the internet is possible. See our FAQ at http://www.pianoteq.com/faq)
e Windows XP or later, Mac OS v. 10.5 or later (Universal Binary), Linux (x86).

2.6 Adapt Pianoteq to your hardware

When you click on the Options button, a window containing the following sections

-@ﬂc-ll-u’s%&

Devices MIDI Add-ons General  About
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The Devices section (in standalone mode only) lets you select your keyboard, audio
device and related driver (Audio device type), output channels, sample rate and audio
buffer size.

In the MIDI section you can:
» Assign MIDI controllers to Pianoteq parameters (experienced users only — may
produce unexpected sounds with MIDI files containing special instructions)
e Unassign all controllers except pedals and Pitch Bend by choosing Current MIDI
Mapping: Minimalistic (recommended for starting)
e Transpose notes by 3 octaves.

Pianoteq computes all notes dynamically (that is, in real time). Thus a fast CPU is
required. The minimum requirement is a 1.5 GHz CPU. Be aware that bass notes require
more computations than treble, because they contain many more overtones. The Perf
section allows you to select from among the following features:

* Multicore rendering. You should usually enable this feature.

e CPU overload detection. Under certain circumstances (a slow CPU, very fast
music), the CPU may be overloaded by the number of required computations.
CPU overload detection might be useful for real time processing, for example
when 10 seconds of sound require 12 seconds of CPU computations. Some
computations are then by-passed.

e Internal Sample Rate affects the internal sampling rate of Pianoteq. A lower
frequency requires less computation. Thus the lower the capacity of your CPU,
the lower you should set this sample rate.

e The Polyphony is the number of individual sounds (notes, sympathetic
resonances...) that are played simultaneously. The lower the capacity of your
CPU, the lower you should set the polyphony. Alternatively, you can choose Auto
(Pessimistic or Optimistic) for an automatic polyphony setup.

2.7 Quickly loading fxp, ptg and MIDI files

You can drag fxp and ptq files (and MIDI files with the stand-alone version) from the file
manager, email client, web browser, and drop them onto the Pianoteq interface.

2.8 MIDI file player (stand-alone version)

The Pianoteq stand-alone version is equipped with a MIDI player that lets you play and
record MIDI files.

12



2.8.1 Playback speed

You can adjust the playback speed by clicking on x1 (“times 1”). A menu will appear
where you can choose another value or enter any value between 0.1 and 10.
Alternatively, click on x1 and drag the mouse to get the value you want.

1% {-H . -. II }- |-'l--=.-.- e i, ':'r"-x-'=:;| 00:00.0 copyymmann Kreisleriana Op 16 EE 'I"ap' 4|]

T ———

%1

Playback speed jpfions Help =
x0.3

e
; x0.5

2.8.2 Record and Save your performance

Click on the record button to start recording your performance live.

File Edit Window Help
1w 4 mle 1 » | recording 00:04.4

[ —

(/X Tap 40 )
Save your MIDI file by opening the File menu. There you can also export your recording
to an audio WAV file.

(unnarmed)

2.8.3 Brilliant performance lost?

At any time, you can retrieve your recent performances via File->Recently played on the
keyboard. Particularly useful when after a brilliant performance you think “too bad I
didn’t record this”! Well, Pianoteq did it for you: just load the latest Recently played
on the keyboard and save/export it to a regular MIDI/WAV file. It’s as simple as that!

Edit Window

Next preset (unnarmed)

/¥|1ap 120

Optians Help +

Previous preset
Next instrument
Previous instrument

ve preset Random * ¢ |A |

crl + T "-'\

Save preset as.. ctrl + shift + T

NICING NESIG N

WL

gas. T

Audio/MIDI setup hift + O

Load MIDI file ctrl + @
Recent MIDI files LN

Save MIDI file

Ex pao rt Wav file

Quit

22 hours ago:
21 hours ago:
21 hours ago: 28

21 hours ago:

2.8.4 Step by step in your MIDI file

In the standalone version, for exploring your MIDI file step by step, forwards or
backwards, use the right or the left arrow to play single notes or chords.

41 notes played in 18 seconds

layed in 2 seconds

layed in 10 seconds
46 notes played in 32 seconds

13



2.9 Interface magnification

Since version 4, the Pianoteq interface is resizable, making it comfortable to work with
any display size. Click on Options » General and select the size in the Interface

magnification menu:

-aﬂc-n-u&%&

Devices MIDI Add-ons General About

User Interface
Interface magnification b
¥ Display tooltips

Folders

Top-level folder for presets and add-ons

The user presets (FXP files) are stored in the Pres S
are stored in the Addons folder.

normal {100%)

tiny (

small {75%)

slightly reduced (9(
normal {(100%)

a bit larger (125%)

very large (17
huge (200%)

giant (2

14



3 Overview

We come now to a brief overview of Pianoteq. Its interface is divided into two sections:

* An Instrument section containing innovative features presented in three panels
called Tuning, Voicing, and Design. Each panel opens with a single click.

The three Instrument section panels

'lﬁgpmmnTEm a

frm*ﬁ%ﬁ

Satike point

« An Audio Engineering section, which offers you a unique feature available
through the Output menu: microphones positioning and mixing. The section also
offers features like velocity curve, volume, dynamics, action and mallet settings,
equalizer, reverberation, chorus, flanger, compressor and other effects.

The Audio Engineering section

AcTion i
MALLET BOUNCE

EQUALIZER 1

EFFECTS =t

Adjusting any of the parameters is easy. But you can also simply choose your instrument
from the instrument menu on the top left.
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3.1 Instruments

Pianoteq instruments are based on physical modelling — which simulates the way the
sound is generated and how it propagates in space — coupled to a mathematical
analysis of original instruments.

The commercial add-ons are included in demo mode in Pianoteq for your evaluation.
You can download free add-ons from the user area at www.pianoteqg.com.

Eacarmee————— 3.1.1  Acoustic pianos

Pianoteq 4 brings a new virtual grand piano: the D4. A Steinway
D from Hamburg has served as reference. Its characteristics
have been used for feeding the physical model from which the
D4 is issued. The secret of its sound quality lies in the
refinement of the soundboard model and its acoustic radiation
computed via a structural analysis model coupled to integral
equations. Moreover, each note has been adjusted in its finest detail, just like in a real
factory. This new piano has many presets with various recording perspectives that can
serve any style of music. Of course, these are only a few among the infinite number of
perspectives that you can create yourself by choosing your own recording settings:
microphones placement, mixing, etc.

The grand piano K1, while keeping in the medium range the nice and warm sound of the
previous version from Pianoteq 3, has been equipped with new bass strings.

The YC5 Rock add-on is provided as a commercial add-on. It is developed to meet
demands for a specific pop/rock piano. Its bright and vivid tone cuts through in
pop/rock oriented mixes.

The grand pianos C3 and M3, which were included in Pianoteq 3, can be downloaded for
free from the user area (V3legacy.ptq).

Keyboard range extension

Our grand pianos D4, K1 and YC5 benefit from an unprecedented keyboard range
extension from 88 to 105 notes (8% octaves):

T

cccccccccccccccccccccccccccccc DEFGABCDEFGABCDEFGABC

0 1 2‘ 3 4
105 keys : 8%

TR

AOGOEFGABCOEFGADGDEFGABGDEFGABGCOEFGADGCOEFGABGCOEFGADCDEFGABGDEF

-1 o 1 4 s
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3.1.2  Electro-acoustic pianos

The electro-acoustic add-on offers two amazing electro-
acoustic pianos from the seventies. Each instrument (Rhody and
Wurly) is provided with several variants. Using the rich interface
features, you can customize them to your own taste.

3.1.3 Clavinet

The clavinet add-on is modelled after the well-known Dé
electric clavichord. Thanks to the powerful technology provided
by physical modelling, it offers, in contrast with the original
instrument, a sustain pedal, an extended range from CO to Cé
(original range FO to E5), a variable mute bar and continuous
pick-up mixing.

3.1.4  Vibraphones

The Vibes add-on offers two beautiful vibraphones. V-M is a
virtual copy of a Musser vibraphone that belongs to the famous
French vibraphonist Dany Doriz. V-B is a virtual copy of a
Bergerault vibraphone that belongs to the Condorcet studio in
Toulouse (France). The bars are made of metal.

3.1.5 Xylophone and Marimba

The Xylo add-on includes a xylophone and a marimba. The
xylophone virtual copy is modelled after a modern 3%:-octave
French brand and the marimba virtual copy is modelled after a
modern five-octave French brand. In contrast with the
vibraphone, the bars are made of wood instead of metal.

3.1.6  Celesta and glockenspiel

The Celeste add-on includes a celesta and a glockenspiel. The
celesta resembles an acoustic upright piano but houses metal
plates struck by felt hammers resembling piano hammers. The
virtual celesta is modelled after a modern five-octave German
brand. The glockenspiel has also metal plates but they are
struck by hard metal mallets held by the musician. The virtual
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glockenspiel, modelled after a modern French brand, has been slightly extended to
cover four octaves.

3.1.7 Prestigious historical collection

Virtual copies of historical instruments can be downloaded from
our website at www.pianoteq.com. We currently offer free add-
ons of a cimbalom, harpsichords, pianofortes and acoustic
and electro-acoustic pianos. Some of these instruments are
presented in their current state. Their age has caused
imperfections, such as some voicing irregularities, which we
have kept intact. We will continue to enrich this collection.

3.1.8 Other add-ons

Other add-ons, such as church bells and tubular bells, are available for download on our
website at www.pianoteg.com. Subscribe to our newsletter for the latest information.

3.2 Managing instruments and presets

You can load and save instruments from the instruments menu:

This menu lets you choose from a list of built-in instruments and presets, additional
add-on instruments (files with extension .ptq) or presets (extension .fxp) that you have
saved in your Pianoteq folders. More details are provided in section 3.4.2.

3.2.1 Difference between “instrument” and “preset”

The physical model contains a great number of parameters, but only a small part of
them are available through the user interface. When only the user interface parameters
are changed, then we say that it is still the same instrument but a different preset.
Hence presets are understood as variations of a given instrument.
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For example, D4 Spacious and D4 Player Jazz are the same instrument, as the difference
lies in the microphone position which can be defined by the user himself. On the
contrary, D4 Spacious and K1 Close Mic are two different instruments because it is
impossible to obtain one of them by modifying the user interface parameters of the
other.

3.2.2 Instrument modifications

You can change any parameter of the current instrument or preset by moving the
corresponding slider with the mouse. Moving the mouse cursor perpendicularly to the
slider will make the slider move slowly.

- fast move

rare

Unison width S I slow move

Each time you modify parameters in Pianoteq, a few computations are needed to
update the instrument (physical model).

Once you are done, the edit and save buttons to the right of the instruments menu
allow you to edit and save your new preset.

Also have fun trying the Random button, which changes all settings randomly!

3.3 Hints

3.3.1 Creating your own instrument

Generally speaking, you will find it more interesting to make adjustments, large and
small, in several parameters instead of making a single large adjustment. Moving a
single slider to the left may throw the weight of the sound onto other parameters that
you may want to adjust. Moving a slider to the far right may obscure the contribution
other parameters make to the sound, or make their small contribution seem too strong.
Moreover, the parameters that interact may be in separate panels, since each panel has
controls that modify the way in which a single physical component of a piano
contributes to the sound, instead of controlling the sound in general. This manual often
touches on these adjustments. Further experimentation will let you experience the ways
in which the parameters interact. Make a small adjustment in one parameter and a large
one in another. Make large and small adjustments everywhere. You can create almost
any sound that a piano can create, and more.

3.3.2 Brilliance

Brilliance is an important sound quality for achieving good realism. You may want to
adjust it whether you are staying close to the loudspeakers, or listening at low volume
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levels, or using headphones. You can for example change the hammer hardness from the
Voicing panel, or use the EQ from the lower panel.

The keyboard velocity itself plays a crucial role in the sense of brilliance. Visit the
Pianoteq user forum http://www.forum-pianoteq.com/ where users provide velocity
curves for many types of keyboards. See also the tutorial in section 12.4.

3.3.3 Using reverberation

Listening through loudspeakers usually requires significantly less reverberation than
through headphones. The reason is simple: when using loudspeakers, the sound is
naturally reverberated by the room in which they sit. We thus recommend that you
reduce the reverberation mix when using loudspeakers.

Moreover, it is worth mentioning that bypassing reverberation in Pianoteq does not have
the same effect as bypassing reverberation in a sample-based instrument. In the latter
case, unless recording was done in an anechoic chamber, there is a natural
reverberation present in the recorded samples which may not be perceived as
reverberation because the note release cuts the reverb tail itself, whereas in Pianoteq,
there is no reverberation whatsoever when you switch it off. In that case, the sound
loses an important part of its natural quality and may sound strange or synthetic,
particularly with headphones, because in the real world we never hear sounds without
some reverberation. Hence, we recommend bypassing reverberation only when using an
external — or natural — reverberation.

3.4 General commands

3.4.1 Playing with the parameters

In Pianoteq you can modify and create your own presets, save them and share them
with other users. The following commands are located at the top of the interface.

» The edit (pen) and save buttons allow you to edit and save your new preset.

» The freeze checkbox allows you to select the parameters that you want to keep
unchanged when changing instrument or preset. This is a very convenient feature
for “transporting” settings from one instrument to another.

* The random command allows you to randomly change tuning, voicing, and design
parameters. Parameters located in the Audio Engineering section are not
affected by the random command.

» Using the undo/redo commands, you can at any time undo and redo the changes
you have made: up to 100 undos are possible. A right click on the button shows
you the last modification.
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 The AB button allows you to switch between two presets A and B, one being in
the foreground while the other is in the background. The led beside them is
lighted as soon as A and B are different. Clicking on the led copies the foreground
preset into the background preset. A right click on the AB button lists the
differences between A and B. A and B presets have their own undo/redo stack.

3.4.2 Managing and sorting presets

When you click on the edit button, the following presets manager appears:

Mote Edit
andom @ TH e

Preset Name [ Instrument | View mini-presets ‘3
D4 Classical BA Grand D4
D4 Classical AB Grand D4
D4 Jazz BA Grand D4
D4 Jazz AB Grand D4
D4 Spacious Grand D4
D4 Pop Grand D4
D4 Vintage Grand D4
D4 Bebop Grand D4
04 Blues Grand D4
D4 Classical Recording BA Grand D4
D4 Classical Recording AB Grand D4 Bechstein (1896}
D4 Jazz Recording BA Grand D4 CP-80
D4 Jazz Recording AB Grand D4 :hu_‘d"llﬁf
D4 Intimate Grand D4 [ allbanks |B
D4 Pointillist Grand D4 Factory
D4 Impressionist Grand D4 i My Presats

o T
| All instruments |:

Grand D4
Grand K1
Grand C3
Grand M3

feabtures
D4 Classical BA fxp-comer
r
support
workshops
fup-creations
Grand D4, version: 1.0 betadd
Grand classical concert piano

It lets you manage the instruments and presets from the instruments menu. You can sort
them, filter them (see some part of them), rename them, etc.

Sorting

The way presets are sorted can be chosen by clicking in the appropriate column: Preset
name, Instrument or Bank.

Praset Name [ Instrument | Bank MIDI
D4 Classical BA Grand D4 b

A bank is a set of presets that are located in a given folder, except the factory bank
which contains built-in instruments and add-ons provided as ptq files located in the
Addons folder.
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Filtering

You can select the instruments and presets that are visible in the instruments menu
through three different “filters” located on the right side of managing window: search,
All instruments, All banks. You can also click on individual instruments or banks.

Filter displayed presets

[ Aibanks 0

| All instruments |_.'i' Factory

Grand D4 o My Presets

Renaming presets

A double click on a user preset name allows you to rename it. You can also open the
contextual menu by clicking on the small arrows in the MIDI column.

The Pianoteq folders

The easiest way to find the Pianoteq folders is to click on the little folder images to the
right of All instruments and All banks. The Pianoteq folder contains two sub-folders:
» Addons: this is where to store the add-ons provided as ptq files,
» Presets: this is where to store the user defined banks. Each bank is itself a folder
that contains presets with fxp file format.

Importing fxp files

There are two ways of importing fxp files:
» Drag and drop the file into the interface,
» Copy the file into the appropriate folder.

Saving presets

After you have created your new preset, you can save it by simply clicking on the save
button; a popup window will ask you for a preset name and a bank name (default bank is
My Presets). Each time you click again on the save button, you will save the new values
with the same preset name. You can access backup copies with a right click on the
preset name (if there are some).

3.4.3 Assigning a parameter to a MIDI controller

You can assign Pianoteq parameters to MIDI controllers such as those that may be on
your keyboard. Select the parameter slider that you want to assign (right click on the
slider and click on MIDI->Assign MIDI Control) and move the knob of the MIDI controller
that you have chosen for this parameter. Pianoteq will automatically assign the

22



parameter to the controller. More sophisticated possibilities are provided in the
Options/MIDI section.

Any MIDI control may be assigned except the following ones: MIDI controls 6, 38, 96-101
which are used for RPN and NRPN MIDI parameters; controls 120 to 127 are reserved for
various reset operations ("all notes off" etc.); controls 32 to 63 are reserved for 14-bit
precision controllers.

3.4.4

The following table summarizes Pianoteq main controls that are associated with

Instrument controls table

instrument features and will be discussed in the next sections.

Feature Controls Action
Pitch Diapason Changes A (above middle C) frequency
Tuning Temperament Chooses among standard temperaments
Unison width Frequency variation within each unison
(group of three strings)
Octave stretching Stretches octaves
Sound length Direct sound duration Modifies the direct sound duration
Soundboard mechanical ~ Modifies the global sound duration: raising
impedance impedance yields longer sounds
Timbre Spectrum profile Modifies individual intensity of the first
eight overtones
Hammer noise Modifies the hammer noise level
Strike point Changes the overtones level
Soundboard cut-off Raising cut-off frequency enriches high
frequency frequencies of each tone
Soundboard Q factor Raising Q factor shortens high frequencies
duration
String length Controls sound “acidity” (inharmonicity)
Brilliance Hammer hardness Enriches the high frequencies: the harder
the hammer, the brighter the sound
Resonance Sympathetic resonance Controls the amount of sympathetic

Duplex scale resonance

resonances of all strings (the harp)
Controls the amount of Duplex scale
resonances (undamped string parts)

Warning: when adjusting the parameters to extreme values,

one may create

instruments having unusual or even unrealistic properties. Hence one can create sounds
that do not correspond to known instruments.
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4 Tuning panel

Pianoteq allows you to perform all of the tuning operations usually done by a piano
tuner. The Tuning panel contains the following controls:

TIHINIMG

4.1 Diapason

The standard diapason (A above middle C) frequency? is 440 Hz, but you can change it to
other values by clicking on diapason.

4.2 Temperament

The temperament defines the way the scale is tuned. By clicking on temperament, you
can choose from among the following temperaments (see appendix):
e Equal: the standard tuning
e Zarlino (circa 1558): sometimes called the “physicians scale”, based on harmonic
thirds (ratio 5/4) and fifths (ratio 3/2)
« Pythagore (VI A.C.): based on harmonic (pure) fifths except for one (the so-
called “quinte du loup”). Can you hear which one it is?
« Mesotonic, Well-tempered and Werckmeister Il (XVII*"): unequal temperaments
used in baroque music
» Flat: octaves ratio is strictly 2, for use in certain circumstances, for example
with synthesizers.

A unique feature of Pianoteq is that tuning does not follow a pre-computed frequency
table (except for the flat temperament), but takes into account the inharmonicity of
the strings, in the same way a piano tuner does with acoustic pianos. Hence, the
consonance of the notes is improved and the chords have a fuller and richer sound.

? Frequency is the number of oscillations per second.
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For other temperaments, you can enter the microtuning panel by clicking on the “mu”

button <22 and there import your own scala® files or keyboard mappings via the scale
and keymap menus:

4.3 Unison tuning

As very few people know, the three strings of each piano unison (the strings hit by each
hammer) are not tuned at exactly the same frequency. To change the timbre or colour
of the sound, a skilled piano tuner introduces small tuning differences between these
three strings. Experiment yourself by gently changing
» The unison width, that is, the difference between the lowest and the highest
frequency produced by the three strings of a single note.

4.4 Octave stretching

It is quite usual to stretch octaves® in a piano, but how much should they be stretched?
Well... this might be a matter of taste! Adjust it to your own taste by modifying
» The octave stretching parameter. The main effect will be observed in the treble
notes.

When the octave stretching parameter is set to 1, the stretching follows the natural
inharmonicity of the strings (depending on the string length), so there still is a slight
stretching. If you want no stretching at all, then use the flat temperament.

3 For more information, see http://www.huygens-fokker.org/scala/

* The musical interval between the two closest notes with the same name (e.g. A3 and A4) is
called an octave. The theoretical frequency ratio between two such notes is 2, but in practice it
is slightly stretched because the ratio between the fundamental and the second overtone of a
real string is slightly greater than 2 (cf. also Design Panel).

25


http://www.huygens-fokker.org/scala/

4.5 Direct sound duration

One consequence of modifying unison frequencies is that you change the direct sound

duration. The same thing happens when reshaping hammers. If you prefer, you can act
directly on this duration by changing:

 The direct sound duration.

direct sound

remanent sound

amplitude
amplitude (dB)

u] 05 1 1.5 2 2.5 3 “o 05 1 1.5 2

25 3
time

time
Time representation of a piano sound decay, natural scale (left) and log scale (right).
Fast decay at the beginning (direct sound), slow decay after (remanent sound).
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5 Voicing panel (acoustic)

The strings of a piano are struck by the hammers, small wooden pieces covered with
hard felt. For a piano tuner, voicing consists in “shaping” the sound according to the
pianist’s taste. This is done by working on the hammer felt, giving it the desired shape,
hardness and elasticity.

Pianoteq allows you to perform this same voicing operation. The voicing panel offers
you the following controls:

VIOYICINTG

5.1 Hammer hardness

Here you can choose the hammer hardness at three different velocities:

» Piano, corresponding to MIDI velocity 32

e Mezzo forte, corresponding to MIDI velocity 64

* Forte, corresponding to MIDI velocity 96.
The harder the felt, the more brilliant the sound becomes. Of course, the louder you
play, the harder the felt should be, unless you wish to try some original playing effects!

5.2 Spectrum profile

Here you will find small sliders that allow you to adjust the individual intensity of the
first eight overtones (cf. section 8.2). Experiment with it by increasing the weights of all
fundamentals (the first overtone is called the fundamental) by raising the first bar.
Depending on the piano brand, the seventh, eighth or ninth overtone is usually weaker
than the other overtones : the strength of the overtones is related to the hammer strike
point defined by the piano manufacturer.
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Time, frequency and time-frequency representation of a note, before and after voicing.
Here, among other things, the first overtone intensity has been increased.

5.3 Hammer noise

You can adjust the hammer noise, that is, the weight of the hammer percussion sound.
With a loud hammer noise, you will feel as though you are standing close to the piano.

5.4 Strike point

The strike point slider allows you to choose the position where the string — or the bar
for percussion instruments — is struck by the hammer or the mallet.

A special humanization feature allows the strike point to vary as if it was played by a
human musician. This feature is particularly suitable for the chromatic percussion
instruments. Right click on the strike point slider and select humanize. You can adjust
the range of the random variation on both sides of the mean strike point.

Strike Point
1/3.0 ¥  MIDI Note Edit | [ Humanize |

Prob. Density: | .El
5.5 Soft pedal

Here you can control the smoothing degree of the una corda pedal, also called the soft
pedal. Despite its name, the una corda pedal usually lets the hammer strike the three
strings, but with a softer part of the hammer felt.
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6 Voicing panel (electro-
acoustic)

The tone sources (reed, tine, bar) of an electro-acoustic piano are struck by hammers or
mallets whose hardness can vary, depending on the material that is used. Here again, as
for acoustic pianos, Pianoteq provides a voicing panel that offers the following
parameters:

’?ﬁ’d f"..# .:r'.-r.d -~

Hammer hardngss
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Hammer hardness, spectrum profile and hammer noise work in the same way as with
acoustic instruments.

6.1 Pickup symmetry

In an electro-acoustic piano, the pickup is not exactly in front of the tone source at rest.
When it is exactly in front, due to the symmetry of the device, the note jumps one
octave higher than the normal tone. Moving the Pickup symmetry slider from left to
right makes the pickup move from an unsymmetrical position to a symmetric position,
providing thus a wide range of timbres.

6.2 Pickup distance

The pickup distance slider sets the distance between the tone source and the pickup.
When the pickup is moved closer to the tone source, the sound becomes more distorted
and the timbre variation between soft and loud sounds increases.

29



/ Voicing panel (clavinet)

The clavinet works much like a clavichord. When a key is depressed, a small rubber tip
strikes the string and presses it on to an anvil. It contains two sets of pickups, positioned
above and below the strings, and is usually electronically amplified.

The voicing panel of the clavinet lets you choose among the four standard pickups
settings:

* A-C: Lower pickup

e B-C: Upper pickup

e A-D: both pickups

» B-D: both pickups but out of phase.

Even more, it lets you make any continuous change between these four settings by using
the Upper pickup and Lower pickup sliders.

Hammer
Piano
Mazzo
Faorte
10 Speciourm profjle
HFEHEEHEBOBEOEEDO
-10

Hammer noise

Pickup u
L

Hammer hardness, spectrum profile and hammer noise work in the same way as they do
with acoustic instruments.
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This panel offers controls over piano design parameters such as string length or
soundboard characteristics (the soundboard is the wooden plate which transmits the
string vibrations to the air.)

8.1 Soundboard

On a real piano, you cannot change the soundboard mechanical impedance®. With
Pianoteq, it becomes very easy: it is just one of the design parameters. You can control:
» The soundboard mechanical impedance: the greater the impedance, the longer
the sound becomes.
» The soundboard cut-off frequency: the higher you set this frequency, the more
high overtones will be present.
e The soundboard Q factor: the greater this factor, the faster the high overtones
will decrease.

8.2 String length

Each piano note produces a complex sound, mainly composed of overtones with
approximate frequencies f, 2f, 3f... where f denotes the fundamental frequency.

A parameter which greatly affects the timbre (and the tuning) is the so-called
inharmonicity: the more inharmonic the strings, the more the overtone frequencies of
each string are driven away from their theoretical values f, 2f, 3f... and the more the
piano sound will resemble a bell.

Inharmonicity decreases very rapidly with string length. Experiment by changing the
String length. The difference will be most evident in the bass range. You can choose up

> That is, how the soundboard resists the string vibrations, and thus amplifies the sound.
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to a 10 meter long piano! At such a size, there is almost no inharmonicity. People say
that piano manufacturers dreamed of producing pianos without inharmonicity...

8.3 Sympathetic resonance

The Sympathetic resonance parameter controls the weight of the strings’ sympathetic
resonances. It is used, for example, in the famous piece microcosmos by Béla Bartok.
The sympathetic resonances depend on the position of each individual damper, and
consequently on the position of the sustain pedal: it is longer when the sustain pedal is
down, for dampers do not touch the strings.

Experiment by pressing down a few keys very slowly so that they do not produce any
sound, and then, without pressing down the sustain pedal, play a few notes staccato.
You will hear the resonance introduced into the first depressed notes. If you release
these notes, the sound will stop.

You can also do the “opposite” experiment. Play a note loudly and hold it, press silently
another note, and release the first note: it continues resonating in the second note.

8.4 Duplex scale

The Duplex scale parameter controls the weight of the duplex scale resonance, issued
from the undamped string parts located between tuning pins and frame (front scale) and
between bridge and frame (rear scale). This invention was patented by Steinway (who
consulted with the physicist Hermann von Helmholtz) in 1872 and enriches the harmonic
content of the notes.
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9 Velocity panel

On the left side of the Audio Engineering section, you can find a velocity control curve,
allowing you to adjust Pianoteq to your keyboard. You can add or remove control points
(double click to remove) and modify the curve by moving them with the mouse. The
upper menu lets you separately adjust Velocity, Pedal and Note-off velocities.

A right click on the velocity graphic opens a menu where you can select and manage
velocity presets.

Paste (ctrl + V)
kKeyboard calibration assi
View

| " Mote-on

s Ay % Mote-off v
o

Sustain pedal velocity mi
Preset

Fast keyboard

Moderately
Mormal keybs

vboard

My Roland Velocity

Manage presets...

The calibration button opens the Keyboard calibration assistant which will help you
adjust Pianoteq to your keyboard and pedal and to your own playing style. We highly
recommend that you follow that procedure at least once. See also tutorial 12.4.

The reset button resets the displayed velocity curve to the default curve.
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10 Output panel

In the middle of the Audio Engineering section you will find:

A menu that allows you to choose from among four modes: stereophonic,
monophonic, sound recording and binaural. The sound recording mode lets you
set microphone positions for acoustic instruments. The binaural mode includes a
head model and is mostly intended for use with headphones. The stereophonic
and monophonic modes are used with electro-acoustic instruments and also allow
compatibility with previous Pianoteq versions. Click on save as for saving your
mic settings.

A volume VU meter, equipped with a limiter than can be turned on/off by a
simple click. By reducing high amplitudes, the limiter is intended to avoid casual
cracks that appear when the amplitude is too high (in such a case, the clipping
led to the right of the vu-meter shows up).

The sound volume. You can adjust it note by note via a double click on the slider.
The sound dynamics, which controls the loudness level between pianissimo and
fortissimo. Since it is applied to each note, it can be seen as the ideal
compressor for it allows you to adjust the dynamics without any distortion. In
particular, the attack and decay of individual notes are not modified.

Four pedals, from left to right:

o Una corda pedal, also called soft pedal. It moves the piano action to the
right, so that the hammers strike the strings differently, changing the
timbre of the notes

o Harmonic pedal, allows you to play staccato while maintaining the sustain
pedal resonance effect

o Sostenuto pedal, allows you to hold some notes after release without
pressing down the sustain pedal. Depress some keys, depress the
sostenuto pedal, release the keys, and the sound of the notes will
continue as long as the sostenuto pedal is down

o Progressive sustain pedal, allows so-called “half pedals”, but also quarter
or tenth’s pedals if you want! °

10.1 A sound radiation physical model

The Pianoteq instruments are based on a physical model of the soundboard and its
radiation. It simulates the sound field generated by the instrument, and thus allows you
to place microphones anywhere around the piano, or just above the soundboard, or
even below the piano if you want. The sound pressure is measured at the place where
you place the microphone, simulating a perfect omnidirectional microphone. However,

¢ If your piano supports a fine enough MIDI progression when using the sustain pedal.
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for distant microphones, as the reverb process is decoupled from the sound radiation of
the piano, turning the reverb off is equivalent to having a perfect directional
microphone oriented towards the piano.

A head model is also provided: here, an additional treatment is applied to the sound
pressure registered by the ears of the listener. It can provide an increased realism when
listening with headphones.

10.2 Sound recording mode

If you have chosen the recording mode, you can drag a mic to any location around the
instrument. You can detach the mic window by hovering the mouse cursor above the mic
area and dragging it with the mouse.

The mix table allows you to mix the microphones into the different output channels. For
each active microphone and each active channel, you can adjust the volume and the
delay that you want to be applied by clicking in the corresponding cell. Which channels
are active depend on your audio configuration.

QUTPUT 1
QUTPUT 2
QUTPUT 3

QUTPUT 4

QUTPUT 5
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10.3 Compensation

When switched on, Level compensation and Delay compensation compensate
respectively for the level and delay on each line connecting a microphone to a channel.
When switched off, the raw sound from the microphones is heard: the volume decreases
with the distance from the piano while the delay increases. In both cases, level and
delay that you adjust in the mix table are relative to the chosen configuration.

COMPENSATION

0N 0N

1 FAFI ] NFl |"|I‘|"-

10.4 Stereo width and sound speed

Two other parameters can be adjusted in the sound recording mode:
» The stereo width. This parameter allows you to narrow or broaden the stereo
image of the instrument,
e The sound speed. Since this parameter was present while we developed the
model, we chose to make it available for you. Its effect is equivalent to changing
the time unit. It modifies the travel time of the sound waves in the air.

10.5 Lid position

The lid can be raised or lowered. Hover the mouse over the top edge of the lid and drag
the lid to raise or lower it. This feature appears in the same panel as the microphone
position because it is part of the acoustic radiation model and thus directly influences

the sound waves captured by the microphones.
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10.6 Binaural mode

If you have selected the binaural mode, you can choose the position of the listener
around the piano. You can rotate the head in any direction, and you can even increase
its size (for big headed people only).

10.7 About the microphones position

As is well-known among sound engineers, the microphone position has a dramatic effect
on the resulting sound of the piano: for some positions, the sound is nicely balanced
from low to high frequencies while other positions lead to a strongly coloured sound.
There might be places where some frequencies are almost completely missing (wave
nodes), and even the best position is far from rendering a purely flat response:
recording always brings some additional colour, which makes sound recording a real art.

The next graphic gives an idea of how “flatness” can vary with the position: the lower a
point of the surface, the flatter the response becomes.
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ACTION

MALLET BOU

11 From action to effects

The lower right panel gives access to the Action, Mallet Bounce, Equalizer and Effects
settings. The buttons below it provide a shortcut for enabling/disabling the selected
effects and the reverb.

11.1 Action

Here you can adjust several parts of the piano action:

» Damper position: when a note is released, the damper falls back on the strings
and each overtone decays more or less rapidly depending on the damper position.
It is particularly noticeable in the bass notes when using partial pedals (and also
with keyboards sending variable key release velocity),

e Damping duration (efficiency of the dampers),

» Last damper: all keys with MIDI note number greater than this value have no
damper,

e Mute: makes the dampers more or less press onto the strings,

* Key release noise,

» Sustain pedal noise: “whoosh” when all dampers rise together, as well as when
they fall.

11.2 Mallet bounce

This feature is particularly interesting for the chromatic percussion instruments,
including the cimbalom.

(¢ MALLET BOUNCE
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You can adjust the way the mallet bounces on the bar (or on the cimbalom strings):
« Initial delay: adjust the delay for the initial bounce
» Velocity sensitivity: the higher the sensitivity, the longer the first bounces at
high velocity (the “drop height” has increased)
» Delay loss: adjust the amount of delay loss from one bounce to the next one
» Velocity loss: adjust the amount of velocity loss from one bounce to the next one
e Humanization: adjust the random variation of all these parameters.

11.3 Equalizer

The equalizer works in pre-processing (modifying the model before computing sound).
The fact that it works in pre-processing allows automatic volume compensation: for
example, when increasing the medium spectrum, it will increase the medium
frequencies in each note while keeping the natural balance across the keyboard. In
other words, the middle notes will not get suddenly louder than the other ones. Another
advantage of pre-processing is that it allows very fine variation in the EQ curve, unlike
on a standard 3 band EQ. You can add (click) or remove (double click) control points and
modify the curve by dragging them with the mouse.

ENIIAITFED

11.4 Effects

The effects panel lets you chain three effects that can be switched if wanted.
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The effect menus allow you to select among the following effects: Tremolo, Wah,
Chorus, Flanger, Delay, Amp, Comp.

The following controllers are shared by several effects:

Delay: the length of the delay line in milliseconds

Depth: the loudness variation in dB in the effect

Feedback: the percentage of signal feedback in the effect delay line
Mix: the ratio of the effect and the unprocessed sound

Mono switch: changes the effect from mono to stereo

Rate: frequency of the oscillator that modulates the effect

Stereo: phase offset between the stereo oscillators

Sync switch: its menu allows synchronizing the effect to the tempo
Tone: simple tone control for the delayed signal.

In the Wah effect, the Wah slider itself is the direct controller of the wah-wah effect
(right click on it and click on MIDI to assign it to a MIDI controller). In Auto-Wah mode,
the Wah is modulated by the amplitude of the sound. Specific Wah controllers:

Sensitivity: Auto-Wah is disabled when the slider is at the extreme left. The
more you push it to the right, the lower the amplitude which starts triggering the
Wah effect

Depth: controls the upper limit of the frequency shift for the wah-wabh filter.

The Amp effect simulates an amplifier equipped with the following controllers:

Drive: amount of distortion introduced in the signal
Bass: amplifier low frequencies boost

Midrange: amplifier mid-range boost

Treble: amplifier high frequencies boost.
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The Comp effect is a standard compressor with the following controllers:

Ratio: gain ratio input/output above the threshold

Attack: the time it takes for the compressor to reduce the gain once the signal
reaches the assigned threshold level

Release: the time it takes for the gain reduction to end once the signal drops
below the assigned threshold level

Threshold: the level at which the compressor gain reduction starts

Gain: the gain in the overall level after the compression.

11.5 Reverberation

A new convolution reverberation unit simulates acoustic surroundings ranging from
Studio up to very long reverbs like Cathedral or Taj Mahal. It includes other types of
reverbs such as Plate, Spring, Speakers, Broceliande... In PIANOTEQ STANDARD or
PIANOTEQ PRO, you can even load your own reverb impulses via Load WAV impulse in
the reverb menu.

The reverberation is controlled by the following parameters:

Mix: the relative level in dB between reverberant sound and direct sound
Duration: the length of the reverberant sound

Room size: from 5 to 50m

Pre-delay: the time between the direct sound and the reverberant sound

Tone: a tilt equalizer that only affects the reflected sound, darker to the left,
brighter to the right

Tail / Early reflections: the relative level in dB between early reflections and
reverberation tail.
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12 Practice

And now, a few tutorials to help you understand how Pianoteq works. We will learn how
parameters influence the sound. It is important to notice that Pianoteq also lets you
produce new sounds which could never be obtained from a real instrument.

12.1 Tutorial 1: tuning

What is the difference between a “normal” piano and a “honky tonk” piano? Most of the
difference can be found in the unisons tuning. Each note has three strings, except in the
bass range. The honky tonk sound comes from the fact that these three strings are not in
tune: they do not produce the same frequencies. You can obtain this effect by moving
the unison width slider to the right in the Tuning panel:

Unisen whdih' =SS eee Unison width fﬁ
Normal tuning Honky tonk tuning

However, having the three strings perfectly in tune is not necessarily best. If you push
the slider completely to the left, the three frequencies of each unison will match almost
perfectly, but you will find that the sound becomes uninteresting. It sounds too “clean”;
it lacks life. So, how should it be tuned? There is no universal truth in such an aesthetic
matter. That is why Pianoteq, for the first time in a digital piano, lets you adjust the
unison tuning to your own taste!

When changing unison width, you may also find it interesting to change the direct sound
duration, reducing it if you have reduced unison width and vice versa. Observe that the
closer the strings are to being in exact unison, the faster the direct sound will decay and
the slower the remanent sound will decay.

Unison tuning is not the only feature that affects tuning: another question is how
intervals, that is, the frequency ratio between two different notes, are tuned. The
tuning of all the intervals within an octave is called a temperament.

Over the years, many different temperaments have evolved. The most commonly used
today is the equal temperament, in which all semitones are equal. However, a few
hundred years ago, people used many other temperaments, some of which you can
choose in the temperament menu. Try playing them. You may find the difference not so
evident when playing single notes, but much more prominent when playing chords,
some of them having a nice consonant sound, whereas others having a quite harsh
sound.
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12.2 Tutorial 2: voicing

The main objective of piano voicing is setting the brightness of the sound by adjusting
the hammer hardness. Different music may require different voicing. The Voicing panel
contains three hammer hardness sliders. Try first moving the mezzo slider, which acts
on the hammer hardness around MIDI velocity 64. Moving it to the left, you will obtain a
softer sound, whereas moving it to the right yields a brighter sound:

Hammer hardness Hammer hardness

Piano —"—_-l:i Plano “. = ]

§onb B e By

Mazzo “ —_— Mazzo _u_,_
Forte -

- Farte __.“

Normal setting Bright setting

Once you are familiar with these sound changes, you can try the other two sliders acting
at piano level and forte level respectively. You may also want to experiment with using
the hammer noise parameter in conjunction with this hammer hardness setting. You
can, for example, set the hammer hardness to very soft, but increase the volume of the
hammer hitting the string using the hammer noise setting. In other words, reducing the
hardness of the hammer doesn’t mean that you have to lose the percussive sound of the
hammer as you reduce the brightness of the sound. On the other hand, you may want to
have hard hammers to make the timbre bright, but at the same time reduce the volume
of the percussive knock of the hammer hitting the strings.

Another feature is timbre adjustment through the intensity of the individual overtones,
which can be partially performed on a real piano by shaping or needling the hammers.
» Try moving the overtone sliders one by one in the spectrum profile, starting with
the first overtone, also called the fundamental.
» Experiment by increasing the eighth overtone by 15 dB. A funny sound, isn’t it?
* Next, try some more global shaping, raising or lowering, for example, the first
three overtones:

Voicing is not independent from tuning, for shaping the sound during tuning can be
considered as voicing. Do you want to obtain longer decay? Then you can:
* Act directly on tuning by reducing the unison width in the Tuning panel,
e Act indirectly on tuning by increasing the direct sound duration,
» Act on design parameter by increasing the soundboard mechanical impedance in
the Design panel.
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12.3 Tutorial 3: soundboard design

Soundboard impedance plays a crucial role in piano design. What is the soundboard
mechanical impedance? When a periodic force is applied to the soundboard, the wood
oscillates with a certain velocity at the same frequency as the applied force. The
soundboard impedes (resists) with its inertia, elasticity and resistance: this is the
mechanical impedance, which has a ratio of force / velocity.

Typically, a high impedance results in a long sound because the energy is only slowly
transmitted from the strings to the soundboard, and vice versa. High impedance yields
long but weak sounds whereas low impedance yields strong but short sounds. Hence
piano manufacturers have to find a compromise between sound level and sound
duration.

With Pianoteq’s solution, you are free to amplify the sound as much as you want. There
is no more compromise. You can set the impedance, adapting it to the sound duration
that you want:

» The first slider, impedance, acts globally on the impedance at all frequencies.
Moving it to the right will result in longer sounds and vice versa.

The mechanical impedance depends on the frequency. The impedance is usually quite
high below a certain frequency called the cut-off frequency, above which it drops down
with a slope called the Q factor: the rate at which impedance is reduced and thus the
rate at which the sound decreases in length. Higher frequencies decay more rapidly than
lower frequencies. Hence:

* Moving the second slider, cutoff, to the right will increase the cut-off frequency,
and thus increase the number of high overtones that are long.

e Moving the third slider, Q factor, to the right will increase the impedance slope,
and thus decrease the duration of the overtones above the cut-off frequency.
Moving it to the left will instead allow these overtones to decay more slowly,
prolonging the initial bright sound just after the attack.

Example: if you like emphasizing the sound of the strings, you can reduce the Q factor.
Alternatively, you can increase the impedance or the cutoff.
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12.4 Tutorial 4: adapting Pianoteq to your keyboard

For demanding pianists, it is of utter importance to adapt Pianoteq to the keyboard in
the best possible way.

» Step 1. If your keyboard has its own velocity settings, choose the one you like the
best in general.

 Step 2. Use the Keyboard calibration assistant by clicking on the calibration
button below the velocity window and follow the instructions step by step.

R ———

1HTeHIT ~

Cancel

» Step 3. If necessary, make further adjustments of the velocity curve by moving
the control nodes of the curve or adding new ones.

Further adjustments

Some further adjustments can be done that depend on the instrument you are playing:
» Step 4. Select the dynamics that you want to use, typically between 20 dB and
60 dB. Measurements done on acoustic pianos show a dynamic range of
approximately 50 dB. In piano recordings, due to compression, the dynamic range
is often much narrower. In Pianoteq, when changing dynamics, the forte volume
remains constant while the lower amplitudes are raised or lowered.

Dynamics ._“_

» Step 5. Choose the appropriate timbre when playing piano, mezzo forte and
forte by moving the corresponding sliders in the Voicing panel.

Hammer hardness
Fiana

Mazzo “
Forte _*

You are now ready to play. Note that steps 3 to 5 can also be used to adapt Pianoteq to
a given MIDI file in the best possible way.
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12.5 Tutorial 5: difference between spectrum profile
and equalizer

What is the difference between the spectrum profile (see tutorial 2) and the equalizer?
Let’s look at an example. Open the Voicing panel and set the first two spectrum bars
respectively to +6 dB and +3 dB:

What happens to the sound? All notes are modified: for each note, the fundamental has
been increased by 6 dB and the second overtone by 3 dB. The piano sound has become
globally softer because the higher overtones now have a lower amplitude relative to the
fundamental and the second overtone.

Using several undo’s, put the spectrum bars back to their original values, and now
adjust the equalizer curve, increasing it from 0 dB to 10 dB when going down from 200
Hz to 62 Hz:

~FMIIAVIZED -

What happens now to the sound?

* For all notes with a fundamental above 200 Hz, that is, above G2 (the G just
below middle C), nothing happens, because their overtones are all above 200 Hz,
where the equalizer is a straight horizontal line.

» For notes below G2, the first overtones are modified according to the equalizer
curve. For example, G1 whose fundamental is 98 Hz will have its fundamental
frequency increased by 6 dB, whereas the other overtones remain almost
unchanged (because they are above 196 Hz).

The resulting piano sound will have more bass, with an unchanged middle register and
treble notes.
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13 Pianoteq Pro

Pianoteq Pro is the advanced version of Pianoteq. It includes the following additional
features:

* Note per note adjustment for physical parameters: tuning, unison width, hammer
hardness, strike point, string length, spectrum profile, soundboard impedance,
damper position... This note per note adjustment is available in the Standard
version only for tuning and volume.

e Sample rates available up to 192 kHz (limited to 48 kHz in the Standard version).
Be aware that a high sample rate will generate a massive increase of CPU load.

13.1 Note Edit

The Note Edit (note per note adjustment) of parameters is a very powerful tool that lets
you adjust the chosen parameter for each note.

L‘“ Piancteq v4.0.0
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Direct Sound Duration

T NNTEEDIT -

g 0 0 0

47



You access the Note Edit window by clicking on the Note Edit button or by double
clicking on an “editable” slider. You can drag the Note Edit window anywhere on your
screen and open several new windows, allowing you to work on several parameters at
the same time as you can see in the picture above, where Unison width and Direct
sound duration are being adjusted.

Observe the handles that let you perform some more global changes on the curve. These
handles are located on specific control notes that you can select/unselect by a double
click on the control rail below the graphic. These control notes are shared by all
parameters except the special case of the spectrum profile which is described in the
next section. For fine tuning, press the Shift key while moving a point of the curve.

Clicking outside a control note lets you modify any other note individually.

Convenient tools are provided that allow you to modify a given shape: random, smooth
and rescale. Click and drag the mouse around the button to vary the degree of the
effect (see also the tips that are provided on the interface). The reset button resets all
parameters to the saved settings of the preset (contained in the fxp file on the hard
drive).

13.2 Spectrum profile

The Note Edit of the Spectrum Profile works a bit differently from the other
parameters, for you can adjust each overtone for each note! You can access it by a
double click on any of the spectrum profile sliders.

Overtones can be modified individually, but also in different combinations called
harmonic, comb, major, octave... Various draw modes named simple draw, haircut and
fill only are also provided. All these features are grouped in the same menu on the
right, labeled simple draw at first access.
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The spectrum profile has its own set of control notes that you can select/unselect by a
double click on the control rail below the graphic. They are independent of the control
notes used by the other parameters.

—
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Outside the control notes, the spectrum profile is linearly interpolated, and you can
observe the intermediate values by clicking on the corresponding note on the control
rail.

13.2.1 Example 1

If you set a single control note and increase its third overtone by 6 dB, all of the notes
will have their third overtone increased by 6 dB:

With a single control note...

Double-click ta edit this note

|

.. all other notes are modified in the same way.
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13.2.2 Example 2

Here — starting with a reset to clear everything — since we wanted only the middle C to
be modified, we added 2 control notes on each side to prevent the interpolation from
“propagating” to the other notes:

With three consecutive control notes...

00

Mote: C#3 (61)

... you can alter only the middle note if you want to prevent your edit from spreading to
the notes above or below it.
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13.2.3 Example 3

In this last example, we modified the middle C and the C below, and we observe how
the intermediate notes are interpolated:

Profiling the middle C...

... and the C below ...

Mote: F2 [53)

... results in interpolated values for the F between.
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14 Appendix: temperaments construction

MATLAB programs for some Pianoteq built-in temperaments’. Inputs are equal tempered
frequencies £ (which may be stretched) and corresponding MIDI numbers.

delta = 3/2/2"(7/12);
ratio = delta.”[-3 -8 -1 -6 1 -4 3 -2 =7 0 -5 271;
f = f.*ratio(rem (MIDI,12)+1);

ratio2C = [1 25/24 9/8 32/27 5/4 4/3 45/32 3/2 25/16 5/3 16/9 15/8];
ratio = ratio2C./2.7((0:11)/12);

ratio = ratio/ratio(10); % leaving A unchanged

f = f.*ratio(rem(MIDI,12)+1);

q = 57(1/4);
ratio2C = [1 5*q~3/16 q*2/2 4*q/5 5/4 2/q 5*q*2/8 q
25/16 q~3/2 4*q"2/5 5*q/4];

ratio = ratio2C./2.7((0:11)/12);
ratio = ratio/ratio(10); % leaving A unchanged

f = f.*ratio(rem (MIDI,12)+1);

q = max(real (roots([1 0 0 2 =-81))); a = (128/g"5)"(1/7);

ratio2C = [1 a”2*g"5/16 g*2/2 a~4*g"5/32 g™4/4 2/a a*qg"5/8 g
a”3*g”5/16 g*3/2 4/a”2 a*qgt4/4];

ratio = ratio2C./2.7((0:11)/12);

ratio = ratio/ratio(10); % leaving A unchanged

f = f.*ratio(rem (MIDI,12)+1);

ratio2C = [1 256/243 1.1174 32/27 1.2528 4/3 1024/729 1.4949
128/81 1.6704 16/9 1.8792];

ratio = ratio2C./2.7((0:11)/12);

ratio = ratio/ratio(10); % leaving A unchanged

f = f.*ratio(rem(MIDI,12)+1);

7 Some of these temperament definitions derive from “Der Piano und Fliigelbau, Herbert
Junghanns, Verlag Das Musikinstrument Frankfurt/Main, 1979”
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Redistributions of source code must retain the above copyright notice, this list of conditions and the
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Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
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CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

* LIBJPEG. This software is based in part on the work of the Independent JPEG Group.
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copyrighted by their respective holders.

55



	1 Introduction
	1.1 The fourth generation of pianos
	1.2 What makes Pianoteq outstanding
	1.3 Pianoteq versions
	1.4 Features in short

	2 Installing and starting Pianoteq
	2.1 Installation for Windows
	2.2 Installation for Mac OS X
	2.3 Using Pianoteq stand-alone
	2.4 Using VST hosts
	2.5 Hardware requirements
	2.6 Adapt Pianoteq to your hardware
	2.7 Quickly loading fxp, ptq and MIDI files
	2.8 MIDI file player (stand-alone version)
	2.8.1 Playback speed
	2.8.2 Record and Save your performance
	2.8.3 Brilliant performance lost?
	2.8.4 Step by step in your MIDI file

	2.9 Interface magnification

	3 Overview
	3.1 Instruments
	3.1.1 Acoustic pianos
	3.1.2 Electro-acoustic pianos
	3.1.3 Clavinet
	3.1.4 Vibraphones
	3.1.5 Xylophone and Marimba
	3.1.6 Celesta and glockenspiel
	3.1.7 Prestigious historical collection
	3.1.8 Other add-ons

	3.2 Managing instruments and presets
	3.2.1 Difference between “instrument” and “preset”
	3.2.2 Instrument modifications

	3.3 Hints
	3.3.1 Creating your own instrument
	3.3.2 Brilliance
	3.3.3 Using reverberation

	3.4 General commands
	3.4.1 Playing with the parameters
	3.4.2 Managing and sorting presets
	3.4.3 Assigning a parameter to a MIDI controller
	3.4.4 Instrument controls table


	4  Tuning panel
	4.1 Diapason
	4.2 Temperament
	4.3 Unison tuning
	4.4 Octave stretching
	4.5 Direct sound duration

	5  Voicing panel (acoustic)
	5.1 Hammer hardness
	5.2 Spectrum profile
	5.3 Hammer noise
	5.4 Strike point
	5.5 Soft pedal

	6 Voicing panel (electro-acoustic)
	6.1 Pickup symmetry
	6.2 Pickup distance

	7 Voicing panel (clavinet)
	8  Design panel
	8.1 Soundboard
	8.2 String length
	8.3 Sympathetic resonance
	8.4 Duplex scale

	9 Velocity panel
	10 Output panel
	10.1 A sound radiation physical model
	10.2 Sound recording mode
	10.3 Compensation
	10.4 Stereo width and sound speed
	10.5 Lid position
	10.6 Binaural mode
	10.7 About the microphones position

	11 From action to effects
	11.1 Action
	11.2 Mallet bounce
	11.3 Equalizer
	11.4 Effects
	11.5 Reverberation

	12 Practice
	12.1 Tutorial 1: tuning
	12.2 Tutorial 2: voicing
	12.3 Tutorial 3: soundboard design
	12.4 Tutorial 4: adapting Pianoteq to your keyboard
	12.5 Tutorial 5: difference between spectrum profile and equalizer

	13 Pianoteq Pro
	13.1 Note Edit
	13.2 Spectrum profile
	13.2.1 Example 1
	13.2.2 Example 2
	13.2.3 Example 3


	14 Appendix: temperaments construction 
	15 Special acknowledgements
	15.1 Instrument providers
	15.2 Recording engineers


